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Changing to OS X
Many long-time Mac users will be surprised when they see their new OS X desktop! 
OS X Advantages

· Improved security: All users must log in to CCSF Macs. Privacy/security built-in for multiple users on same machine: everyone has their own Home and Documents folders that can’t be seen by anyone else. Shut down or Log Out when leaving.

· Better Graphics: A completely redesigned Aqua interface. Adobe Type Manager no longer needed to smooth screen fonts.

· Improved Memory Management: Force Quitting a program (from the Apple menu or dock) closes only that program; doesn't destabilize the whole system. 
And, you don't need to set (or reset) memory requirements for each program. 
· The new Dock shows at a glance which programs are running in memory.

OS 9 ( X changes: Quickstart
Menus have changed, so you'll have to relearn some familiar clicks. A detailed, menu-by menu description follows, but here are some highlights

· Starting Programs: Instead of the Applications listing on the Apple menu, start programs from the Dock or from Recent Items on the Apple menu. You can, of course, open the Applications folder and double-click a program icon.

· Printing setup: No Chooser. Instead: double-click Hard disk icon -> Applications -> Utilities -> Print Center. (Print Center is already placed on the Dock on CCSF Macs.) You can still print from applications from the File menu or with Command-P.

· Shutting down (and sleep, restart): On Apple menu (No Special menu).

· Control Panels: Replaced by System Preferences on the Apple Menu.

· Rolling up Windows: No more. Now you click a window’s middle (yellow) button, top left to minimize that window to the dock. Keeps your desktop uncluttered. And offers one-click access to minimized windows.

· Making a new folder: Press ( - Shift-N. Now (-N opens a new Finder window.

· Open/Eject CD: Press the top right key (marked () to open CD, or press  (-E. 
Drag CD icon to trash to eject disk.

Gone from OS X

· Rebuilding the Desktop: No need in OS X. You still have to do it (from the Classic entry in System Preferences) if you use Classic mode.

· Managing Extensions and Control Panels: No dropping stuff into your System Folder, no Extension Manager. Instead, use the Apple menu’s System Preferences.
· Setting memory requirements for individual programs: Handled automatically.

· SimpleText: Replaced by Text Edit (Services ( TextEdit from Apple Menu).

· Chooser: Replaced by the Print Center (On CCSF Macs’ Dock. Or: Open the Hard disk, then Utilities, then Print Center).

· Graphing Calculator, Scrapbook: No OS X equivalents, just gone.

Finder Menu Changes
The Finder has changed: Here are some translations to help you over the hump.
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Old Finder Menu bar
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New Finder Menu bar

	Old Finder menu
	New Finder menu
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	No Chooser in OS X
· Replaced by Print Center (Print Center is on the Dock of all CCSF Macs).
· If not on Dock: Double-click Hard disk ( Applications ( Utilities ( Print Center 

No Applications listing

· Recent Items entry lists recently used programs AND documents

· Start applications from the Dock, from the Go Menu or from the hard disk
No Control Panels 

· Replaced by System Preferences
Force Quit lists running programs. Select one and click Force Quit.

Sleep, Restart, Shut Down moved from old Special Menu.
Log Out disconnects the user from the system. 
· Use this option for security if you are leaving the computer for a while or if other people are set up to use the computer and you don’t want to make them boot it up.

	Finder Menu
	(No Finder Menu in OS 9)
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	Preferences enables you to configure:
· What to display on your desktop
· Where a  new finder window starts

· Finder window defaults

Empty Trash moved from old Special menu

· Or: Control-Click on the Trash icon in the Dock and choose Empty Trash

· Or press (-Shift-Delete

Services allows you to start TextEdit (SimpleText’s savvier replacement) and other features.

	Old File Menu
	New File Menu
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	New File Menu Comments

· Similar to old: Adding to Favorites allows convenient access to files and folders.

· Use Eject for CDs, other removable disks, or press the ( eject key

· Use Burn disc to backup files/folders to CD

	Old Edit Menu
	New Edit Menu
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	Not changed much! Learn these keyboard shortcuts first!

No Preferences
· Replaced in the Finder by View Options on the View menu

	Old View Menu
	New View Menu
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	View menu “as Columns” option

View ( as Columns is a convenient way of moving through the folders on your hard disk. “As Icons” is familiar. “As Columns” is new. In Columns view, selecting a file that contains a picture opens a column to the right that displays a preview. 

Show View Options allows you to set font size.

Take a look at the Windows in OS X section on page 7 for an example of Columns view.

	No Special menu

[image: image3.png]Special ILET]

EmptyTrash.. 5%

Eject ®E
Burn CD..
-ase Disk.

Sleep
Restart
Shut Down





These commands moved from the old Special menu to:

· OS X’s Apple Menu (Shut down options) and 

· Finder menu (Empty Trash).
· Burn CD moved to File menu. 


New: The Go Menu
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Computer entry opens a finder window showing disks and network connections

· Home opens a finder window showing your Home directory. Each user has a Home Directory where you are expected to save files. You are supplied with several folders in Home, the most important of which is Documents, where you’ll probably choose to put documents. 
Make folders inside Documents to organize your work.
· iDisk takes you to a login screen for Apple’s .Mac web site. This is a pay site (initially $99/year)
· Favorites is a configurable list of files and folders that you want to reference conveniently. You change this list by adding a file or folder to Favorites:
· Select the Finder window item. Choose “Add to Favorites” from the File menu

· Click Add to Favorites when you open or save a document

· Applications opens a window displaying your applications folder.
Spring-loaded folders

When you are arranging your files and folders, the spring-loaded feature allows you to open and preview the contents of prospective destination folders. 
Now you can drag a file to a location several folders deep with a single action.

When you move a file or folder:

1. Select the file(s) and/or folder(s).

2. Hold them over a folder icon instead of dropping them in immediately ( a window zooms open beneath your cursor to reveal that folder’s contents. 

3. Pause over another folder within that window and another window zooms open to reveal those contents as well. 

4. Move out of the zoomed window and it disappears. 

5. Drop the item(s) where you want—all zoomed windows disappear. 

Windows in OS X
Aside from the new Aqua look of windows and window controls, you manipulate individual windows in some familiar, some new, ways. And the Finder has some new options that make it easier to navigate through your hard disk.
[image: image16.png]‘}.g\m\



Moving windows around: Click and hold the top title bar and drag.
Resizing windows: Click and drag the “corrugated” lower right corner.

Rolling up windows: Oops! Can’t do this. Instead, click the middle button of the top-left trio. The window minimizes to an icon on the dock (always to the right of the vertical divider). Click the icon on the Dock to restore the window.
The Dock
The Dock is a strip most often found at the bottom of your screen. It holds Program (and sometimes document or folder) icons and provides a new home for the Trash.
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It allows you to:
· Start programs 

· Check which programs are active at the moment

· Add and delete program icons

· Empty the trash
· Minimize a document you are working on or a folder that you’re looking at into an icon in the dock (to the right of the divider line), just a mouse-click away.

Using the Dock

The Dock is designed as an alternative to creating aliases on the Desktop: it is neater and provides extra functions. But you can still hold down the  ( and Option keys and drag a program’s item to the desktop or elsewhere to create an alias.

· Click an icon on the Dock to start the program it represents. When you hover the cursor over an icon, the program’s title appears above the dock.
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While a program is open (even if you aren’t using it) you can see that it is still running because an arrow appears under its icon. To go back to that program, just click the icon on the Dock.

Opening Programs

OS X can keep several programs open at the same time. To return to a program’s window, just click the program’s icon on the Dock. To switch to another open program, just click its icon. Look at the Windows in OS X section on page 7 to see more ways of working with program windows and the Dock.
Copying between open programs

You can easily cut/copy and paste between applications:

· Copy picture or a text selection from a Web page to a Word Document

· Include data from an Excel Spreadsheet in a Word report

Open the file or Web page you want to copy from and

· Drag to select text or spreadsheet data and, on the menu bar, click  Edit ( copy (or press (-C). Or

· Control-click a picture from the Web and click Copy from the popup menu

· Then: return to your Word document and, on the menu bar, click Edit ( Paste (or press (-V). Note: Sometimes Edit ( Paste Special – Unformatted text works better.
Choosing among open documents
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	If you are, say, working with three Word documents, or have three Web pages open at the same time, you can switch cleanly from one to the other from the dock.

· Control-click the program’s Dock icon. 
· A menu pops up that listing its open documents. 
· Click to choose the one you want to work on—
its window appears


Closing a program
When a program is active you can of course press (-Q or, on the menu bar, click the application’s menu and then Quit. You can also control-click the program’s Dock icon and then click Quit.
Force-Quit an application easily:

1. Open the Apple Menu and click Force Quit

2. Click to choose the program you want to close

3. Click the Force Quit button 
Adding a program icon to the Dock
Method 1: 
· Drag the program’s icon from the Applications folder (or wherever) to the Dock.

Method 2:

Start a program by double-clicking it in the Applications folder to display it’s icon on the Dock:
1. Open the Finder’s Go menu
2. Click Applications
3. Double-click the application you want. When it starts, its icon appears in the Dock with an arrow underneath showing that it is active.
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To keep a program’s icon in the Dock permanently:

1. Control-click its icon on the dock
A popup menu appears

2. On the popup menu, click Keep in Dock
Deleting an icon from the Dock
To delete an icon, drag it off the dock.

You haven’t deleted the program, just its icon.
Making an Alias

OS X provides many alternatives to aliases, but if you want to create them, here’s how:

1. In the Finder, navigate to the folder showing the item you want.

2. Hold down the ( and Option keys while dragging the icon to the desktop 
(or any folder).

Controlling the Dock

Access the Dock’s controls:

· Through the Apple menu’s Dock entry
· By opening System Preferences from the Apple menu and clicking the Dock 
· By control-clicking the vertical dividing line inside the Dock itself
The Dock’s Preferences
Running non-OS X applications
· OS X contains a System 9 clone called the Classic environment.

· You may have some programs that have not yet been updated to run in OS X. Most will run under Classic.

· When you click the icon for one of these applications, you'll see a window that looks like the System 9 startup screen. Extensions gradually load, and then your program appears in its System 9-like window.

· Complications: Printing is set up for these applications from the Chooser. So, if you have printers installed in OS X, they are not available to you until you have loaded them in the Chooser.

Rebuilding the Desktop

Yes, you still have to do it if you use the Classic environment a lot. But you can't do it the old way (holding down Options-Command doesn't work).

Fortunately you can rebuild the desktop even without opening Classic. Here's how:

1. Click the Apple menu icon and choose System Preferences.

2. In the lower part of the window in the System section, click Classic.

3. In the Classic window, click the Advanced tab.

4. Click the Rebuild Desktop button to start the process.

Other resources

http://www.apple.com/macosx/
Apple’s own OS X web site with information about underlying technologies, compatible programs and hardware (scanners, cameras, etc) as well as pages on OS X features such as iPhoto, the new, Internet-only version of Sherlock, and how to use your Mac-supplied CD-burner. 

You do have to watch out for links that are opportunities to spend money (for instance, downloads marked “demo”): that’s the Internet!

http://www.versiontracker.com/
A listing of shareware and free programs. An easy way to keep track of updates and identify the latest version of an application. Also may be able to tell you if there is a new version of an old favorite application that runs under OS X.
Also change the Dock’s size by dragging its vertical dividing line





Magnification makes the dock’s icons enlarge as you pass the cursor over them





When you click a window’s Minimize button, it shrinks into a Dock icon using a special effect of your choice. Click the icon to restore the window


If an application takes a while to start, animating makes its Dock icon bounce until it fully loads





Hiding the dock gains desktop space. Bring the cursor to the edge nearest the Dock’s screen position and it reappears





Excel icon: Program not running (no arrow)


Word icon: Program running—shown by arrow under icon





Icons view





List view





Columns view (this is columns view)





Hides / Displays the icon bar�Rollup replaced by the minimize button





Search for a file or folder by entering all or part of its name


To search for a document by content, press  ( - F to open the Find dialog 





Window control buttons light up when cursor approaches





Use these buttons to control windows.


The yellow-orange center minimize button collapses the current window into an icon on the right of the Dock. It doesn’t save or close any document it may contain. To bring up that window, just click its icon on the Dock.





Maximize the window’s size





Close the window—doesn’t quit an application. Check the Dock to see which programs are running





Minimize the window — turn it into a clickable icon on the Dock (replaces rolling up the window)





Clicking a folder in columns view opens a column to the right. Clicking a file shows an icon/info. �Clicking a picture shows a thumbnail preview.
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